Document Formatting 101
Rev. 3.3
Copyright © 2005 Amer Neely
The purpose of this guidelet is to give you some very basic direction in using a word processor to create a resume. Most of the concepts and techniques will apply to any word processor such as Open Office, WordPerfect or Microsoft WordPad and Word. Since I’m using Word to produce this document, the descriptions and images you will read and see are from Word 2000. Similar features are available in other word processors, but perhaps under different names. The concepts and techniques you learn will also help you with any other documents you are creating.

It is not my intention to present you with pages of complicated things to learn, and certainly not my intention to cover everything there is to know about word processing. If you only learn the few concepts covered here, you should have enough confidence to start with a blank page in any word processor and not feel completely stuck. Something about teaching you how to fish, instead of providing you with a fish.

Have fun; don’t panic; explore on your own; it’s only a document.
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SETTING MARGINS TC "SETTING MARGINS" \f C \l "1" 
One of the first things you will want to know about your document is ‘What are the margins set at?’ Now, you might think that is a silly question, but many word processors have default left and right margins of 1 ¼”. That may be fine for a cover letter, but a resume will probably look squashed, and may run to more pages than you want.

Generally, a 1” left, right, top and bottom margin should serve you well. Here’s how to check and set your margins.

Click the ‘File’ menu tab at the top of the page, and then click ‘Page Setup’. The following box should appear.
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Make sure the ‘Margins’ tab is active, and check the values in the ‘Margins’ section of the box. Don’t worry about the ‘Gutter’ values.

Set the ‘Top’, ‘Bottom’, ‘Left’ and ‘Right’ margins to 1”. 

While you are here, make sure the ‘Orientation’ of the page is set to ‘Portrait’.

In the ‘Preview’ section at the bottom, make sure the ‘Apply to:’ box indicates ‘Whole document’.

When you are done, click ‘OK’ at the bottom.

Now you have a 1” margin all around your document. These will apply to every page in your document, unless you change them specifically for a particular page.

NOT A TYPEWRITER? TC "NOT A TYPEWRITER?" \f C \l "1" 
An important concept to grasp is that a word processor is not just a fancy typewriter. If you wish to avoid a lot of wasted time and grief, try to get some of the following basic concepts solidly under your belt.

With a typewriter, every character you type takes up the same amount of space on a page. You may have had to use an old dot-matrix printer with your computer, and you will recall how the most characters you could get on a line was 80. That is similar to how a typewriter works.

When you were setting up a page with a typewriter, you lined up columns by using spaces. Or if you were really good, you used tabs.

With word processors, each character takes up a different amount of width (except under one condition, that being the font is ‘Courier’). So for example, an ‘i’ takes up less space than an ‘m’. If you were to try and line up columns the ‘old’ way as if you were using a typewriter, you might discover that when you print your document, the columns no longer line up nicely.

The best thing you can do if you want to set up a document with columns, or any text that you want to line up at a certain point,  is learn how to set up tabs and how to use tables. A resume is a typical document you might be working on that requires columns. The ONLY way you will get consistent results with your document if it has columns of text is to use tabs, tables, or both. In specific situations you can actually set up columns, but they are similar to what you see in a newspaper article, wrapping from the bottom of one column into the top of the next one.

ORANGES AND APPLES TC "ORANGES AND APPLES" \f C \l "1" 
M M M M M

I I I I I

As you can see by the example above, the ‘M’ is wider than the ‘I’. Both are set to Verdana 10pt. The spaces between each letter take up the same amount of space.

Here is the same thing but with the font set to ‘Courier’.

M M M M M

I I I I I

Note how each letter takes up the same width. ‘Courier’ is sometimes known as the ‘typewriter’ font, since it simulates what a typewriter looks like.

If you create a document using a particular font, but use spaces to line up your columns, then try to print your document on another computer that doesn’t have that font, you may end up with an unexpected and unwanted surprise.

Here’s some text set up in columns using spaces. The font is Verdana 10pt.

M M M M M          ABCDEFG          HIJKLMNOP

ABC                    DEFGHI             JKLMN

I I I I I                IIIII                  IIIIII

Hmm. Everything looks fine, so what’s the problem?

OK, now let’s say you take your floppy disk with your document to another computer to print out. If they don’t have the exact same font you chose to write your document in, the word processor will replace it with something else. Here is the text above but printed in Courier font. There are the same number of spaces between ‘columns’ as the above example.

M M M M M          ABCDEFG          HIJKLMNOP

ABC                    DEFGHI             JKLMN

I I I I I                IIIII                  IIIIII

Whoa! What happened there? Your nicely formatted columns now look like your pet cat was helping you (or maybe even did all the work).

Now do you believe me when I say you should never use spaces to set up columns? I mean, what do you think tabs are for? Hello!

Now don’t get all panicky and think, ‘Oh no, I’m going to have to learn a bunch of complicated stuff about using word processors, when all I want to do is get my resume printed.’ 

I said ‘Don’t get panicky’, but you will hopefully learn enough about word processing to be able to set up any document so it is ‘professionally’ done. That means NO SPACES for columns.

OK, so you want to print your resume. Hopefully you have a good idea already of the layout you want for it. Chances are it has some text that you want to line up nicely.

SETTING FONTS AND FONT SIZES TC "SETTING FONTS AND FONT SIZES" \f C \l "1" 
Now that we have our margins defined, let’s move on to another attribute that you can set for your whole document. Normally you will want to use the same font for the whole document. Whichever font you choose, you have several options that you can apply.

There are a couple of ways to set fonts, but perhaps the easiest is to use the pull-down selection box at the top of your document. 
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This is what the font and font size selectors look like. You can see that the font name is Verdana, and it is set at 10 points (pts.). Points are a unit of measurement used in the print industry. There are about 72 points per inch.

To select a font, click the down arrow between the font name and size windows. A list of available fonts will be displayed in a drop-down selection box. By clicking on one, you set that font to be used from the position of the cursor, until you either change it again, or you reach the end of your document.

You select your font size similarly, by selecting a value from the drop-down font size selection box.

I’ve bumped up the font size to 12 pts. to show you the difference.

You can even have different font sizes of text on the same line.

Along with changing the size of the font, you have other options to make some parts of your text stand out. Choose from bold, italic, or underline.
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These icons are just above the ruler at the top of your document. Guess what each one stands for. To select Bold click the B once. Everything you type will now be in bold, until you turn off the feature by clicking it again.
BOLD IS GOOD FOR HEADINGS, whereas italics might be used for ‘The Title of a Book’.

Note that you can also have any combination of these features active at the same time. All three of these text ‘enhancement’ icons are toggles, which means each time you click the icon, you change the action to the opposite of what it currently is.
This method of changing a font enhancement is fine when you know ahead of time that the text you are about to enter definitely should be bold, or italic, or underlined.
But what if you already have a bunch of text, say your whole resume, already typed in. How can you quickly add any of these features to the existing text?

SELECTING BLOCKS OF TEXT TC "SELECTING BLOCKS OF TEXT" \f C \l "1" 
This has got to be one of the most useful features of a word processor. It is the basis for several operations such as Copy / Paste and Move.

When you have an existing block of text (and a block of text can be anything from a single letter or punctuation mark to the whole document) which you want to apply a feature too, you can do so by ‘selecting’ the block. There are 2 ways to do this. You can either use the mouse, or the keyboard.

Using the mouse to select text is probably easier for most people, so let’s try that.

Place the cursor just to the left of the word ‘most’ in the sentence above. Then while holding down the left mouse button, drag the mouse to the right until you have highlighted the words ‘most people’. Then let go of the mouse button. Both words should now have a black background – they are now ‘selected’. You can now do several things with the selected text. But since we’re discussing fonts and sizes, that’s what we will stick with for now.

Click the icon for ‘bold’ from the top of the page, and then click your mouse button somewhere on the page. This releases the selected text. What you should see is

Using the mouse to select text is probably easier for most people, so let’s try that. 

Using this method you can quickly select large blocks of text, such as a whole paragraph, or 2 or 3. Simply place the mouse cursor at the beginning of the block you want to select, then while holding the left mouse button down, drag the mouse diagonally across and down the block of text, until you reach the last character of the block.

If you just want to select one word, you can do so by double-clicking on the word.

Selecting text can be done from either the beginning of a block and dragging to the end, or from the end of the block and dragging to the beginning.

For those of you who are ‘keyboard’ friendly, you can also select text without using a mouse.

Position the cursor at the beginning of the block you want to select. Then, while holding down the ‘Shift’ key, either scroll with the right-arrow key to select some text on a single line, or use the down-arrow key to select lines of text. Once selected, perform whatever operation you want on the text, then either move the cursor by tapping any arrow key, or click the mouse somewhere on the document.
For whole documents, the quickest way by far to select all the text is to use the ‘Ctrl-A’ key combination. Hold down the ‘Ctrl’ (Control) key, then press ‘a’ once. Your whole document is now selected, and you can perform document-wide operations on the selected text. We will use a similar combination later when we talk about copying and pasting text.
Get familiar with these methods of selecting text, as it will be one of your most used and powerful tools.

When it comes to producing documents, there are two ways to go. You can either enter all the text first, then go back and format it the way you want (center, bold, right-align, etc.), or you can do your formatting as you go. Whichever way you choose, you will benefit from knowing some of these basics.

COPY / PASTE TC "COPY / PASTE" \f C \l "1" 
Now that you know how to select text, let’s put that knowledge to use. One of the most common tasks you will do when creating a document is moving blocks of text from one location in the document to another. While creating this document I had to move whole pages of text when I introduced a new concept.

Before we learn how to copy & paste we have to introduce something new. It’s called the ‘clipboard’. Think of the clipboard as a handy ummm, clipboard, which you can use as a sort of temporary holding area for bits of your document as you move them from one section of your document to another.

The first step in using the clipboard is of course to get something on it. We do this by first selecting some text. We already know how to do that, so select some text in this paragraph. 
Now, press ‘Ctrl’ and ‘c’ at the same time. Or if you would rather use the mouse, click the ‘Edit’ menu tab at the top of the page, and then click on ‘Copy’. That puts the text you’ve selected onto the clipboard.

Now place the cursor where you want to copy the text. To retrieve what is on the clipboard, key-boarders can press ‘Ctrl’ and ‘v’ at the same time. Mousers click the ‘Edit’ menu tab, then click ‘Paste’. Pasting is what we call retrieving something from the clipboard. I’ve copied the following text and pasted it here:
select some text

One important thing to keep in mind about the clipboard: whatever you place there stays there until you either replace it with something else, or you exit your word processor. This is a very handy feature, but one that confuses some people. Just because you’ve pasted something from the clipboard doesn’t mean it is removed from the clipboard – it is there for you to use over and over if needed.
DELETING BLOCKS OF TEXT TC "DELETING BLOCKS OF TEXT" \f C \l "1" 
Even though we are all excellent writers and rarely make mistakes, some of us might find a need to delete a block of text on a very rare occasion. I mentioned earlier that you can perform several operations on selected text. Guess what? Yep, you can delete whole blocks of selected text just by hitting the ‘Delete’ key. Be very careful with this one. Before you realize what you’ve done, your next literary masterpiece (or large chunks of it) could disappear in the blink of an eye. 
If you ever find yourself in this situation DON’T PANIC!
You have lots of time to fix the problem, so don’t go clicking or ‘trying’ anything. There are 2 things you can do to retrieve the text you’ve mistakenly deleted. The simplest is called the ‘Undo’ feature, and you will be tempted to offer sacrifices to the person who thought this one up. 

Before doing anything, key-boarders press ‘Ctrl’ and ‘z’ – mousers click ‘Edit’ and then ‘Undo typing’. There is also a button you can click right on the toolbar below the menu bar.
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The one we want is the one on the left. Your lost jewel will magically reappear right where you left it.

Another way you can ‘go back in time’ so to speak, is to close your document down WITHOUT SAVING IT. OK, I know that sounds weird but again: DO NOT SAVE YOUR DOCUMENT. Think about it. If you don’t save the ‘changes’ you made, when you open your document again, it will be the way it was BEFORE you made those drastic changes. So close down your document, and then open it again. Of course if you haven’t even saved it once yet, this method won’t work for you.
SETTING TABS TC "SETTING TABS" \f C \l "1" 
The simplest thing to learn is how to set up tabs. Most word processors open a new document with tabs already set about ½” apart. Microsoft Word starts this way, so you can immediately take advantage of them. To see how tabs work and where they are set up, look at the top of the document where there appears to be a ruler. The tabs are indicated by light grey marks under the ruler at the top of your document. 
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I’m going to use the default tab settings to print something at each tab stop. Like a typewriter, you use the ‘Tab’ key to move the cursor to the next tab stop. If you want to move back one tab stop, press ‘Ctrl’ + ‘Left arrow’ at the same time. Don’t use the ‘Backspace’ key or else you will delete the tab stop along with any text.

00
01
02
03
04
05
06
07
08
09
10
11
12

So, now we know there are 12 tabs set up already. Since I set up the page (a regular 8 ½” letter size) with a 1” margin on the left and right sides, that leaves 6 ½” inches of ‘working space’. The first tab stop is at the ‘01’ point. The ‘00’ isn’t a tab stop, but is the left margin. The last tab stop is at the ‘12’ position (6”). You might ask “Why isn’t there one more tab after the ‘12’ position?” For the same reason the first position isn’t a tab stop, the last position isn’t a tab stop, but is in fact the right margin. You can tab to that position, but as soon as you enter any text, the cursor wraps around to the next line, carrying the tab with it.
A quick way to see where tabs are is to turn on the ‘Show/Hide’ button. It should be in the row of icons under the top menu bar, and looks like this: ¶. Clicking it once will show you where all tabs, spaces, and carriage returns are in your document. Clicking it again will hide them. This is called ‘toggling’ a feature.
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Now, tabs come in all kinds of pretty formats. By default all tabs are ‘Left Aligned’. That means when you start typing text at that tab stop, the text will start at the tab, and continue to the RIGHT. In other words, the tab stop acts like a margin.

You can have ‘Left Aligned’, ‘Right Aligned’, ‘Centered’, and ‘Decimal Tab’. There are also a ‘Hanging Indent’, ‘First Line Indent’ and ‘Bar Tab’ (no, that doesn’t mean drinks are free). They each have their special uses. You can even have different types of tabs on the same line. Try doing that on a typewriter! For our purposes though, just get familiar with the first four mentioned.
How do you know which kind of tab stops are in place? Just to the left of the ruler at the top of your document, you will see a small grey button with a black symbol on it. If the symbol looks like a large ‘L’ the tabs are ‘Left Aligned’. Find the button, and hold the cursor over it. A help box should appear telling you which kind of tab is represented by that character. If you click the button with either mouse button, you can cycle through the different kinds of tab stops available. Get familiar with what each one looks like. Here is what the Left-align tab marker looks like.
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OK, all well and fine, but how do you actually SET tabs at different positions?

You could of course just use the default settings at ½” increments, but you want your resume to really stand out from the rest.

Let’s say we want some text left aligned at the 5/8” position. This might be used for a company name, address or starting a new paragraph.
First make sure the tab indicator button is displaying the ‘Left Align’ symbol. Then position the mouse pointer under the 5/8” position on the grey border under the ruler, and click the left mouse button. Since 1 inch contains 8 1/8ths, click on the 5th grey mark from the left on the ruler. Magically, a small ‘Left Align’ tab symbol should appear at that point. Now, start a new paragraph by hitting ‘Enter’, then press the ‘Tab’ key once.


This new paragraph is starting 1 5/8” from the left edge of the page. Don’t forget, we already have a 1” left margin. But since this is supposed to be a resume, let’s put something more reasonable at this tab stop. Note that the tab only affects one line. If more text is entered than can fit on one line, it wraps around and lines up with the left margin again.

1960
US Dept. of Defense creates ARPANET ‘network of networks’. 4 computers.

1971 ARPANET has 23 computers linked

1972
40 computers now in the loop

1982
‘Internet’ used to describe the network of networks

1984
1000 hosts now linked

1989 Tim Berners-Lee creates HyperText Markup Language (HTML)

1990 First commercial dial-up Internet access (The World) world.std.com

1991 World Wide Web is born

1993
Mosaic, first graphical web browser

1994 Over 6,000,000 hosts

Now I know you are just quivering with excitement over this, so calm yourself. Watch what happens when we try the same thing with the dreaded ‘typewriter’ font (‘Courier’).

1960 US Dept. of Defense creates ARPANET ‘network of networks’. 4 computers.

1971 ARPANET has 23 computers linked

1972 40 computers now in the loop

1982 ‘Internet’ used to describe the network of networks

1984
1000 hosts now linked

1989 Tim Berners-Lee creates HyperText Markup Language (HTML)

1990 First commercial dial-up Internet access (The World) world.std.com

1991 World Wide Web is born

1993
Mosaic, first graphical web browser

1994 Over 6,000,000 hosts
Ha. You thought everything would get messed up didn’t you? But the tabs stayed put, and so did the columns of text. Of particular note is the text for the year 1960. Note how it wrapped around to a second line, but didn’t line up at our tab spot. That is an example of a ‘Left Aligned’ tab. What does a ‘Right Aligned’ tab do? Watch.


This text now ENDS at the 3” mark.

So does this text.


A funny thing happens with this tab.


The text moves to the LEFT as you type.


This is so the right end of the line always


lines up.

That’s what a Right-aligned tab does. 

So what do you suppose a Center Aligned tab does?

Let’s find out.


Ok, I’ve set a Center Aligned tab at the 3 ¼” mark.


The text moves to the left as you type, but the cursor also moves to the right.


This double action leaves the text centered on the tab spot.


This tab just happens to be in the middle of the page, and you could 


achieve the same effect by just ‘centering’ this block of text.


But what if you don’t want the lines centered in the middle, but


at the 4” mark?


OK, here’s some new text,


Notice how it is still ‘centered’, but the point it is


centered on is the 4” tab stop.

The last tab we will look at is the ‘Decimal Align’. This one is handy for, guess what? Lining up decimal points! Go figure.

I’ve set up a Decimal Align tab at the 5” mark. Let’s enter some annual salaries.

Me
$160,000.00

You
$27,000.00

Frank Zappa
$1,400.00 (Part time)

Tommy Chong
$13.00 (Casual)

Cheech Marin
$3.51 (Sub urban)

Now that is pretty handy. No fooling around adding and deleting spaces to get things to line up. And as an added bonus, if any of the salaries needs adjusting, you just go in and make the changes, without worrying about lining things up again.

One thing to bear in mind with all tab types: you have to hit the ‘Tab’ key each time you want to move to a tab stop. 
Since you know how to set up a tab, you may as well know how to delete them, right? That’s the easy part. 

First, select the paragraph that contains the tab/s you want to delete. Do this by just clicking somewhere in the paragraph. With your mouse pointer over the tab marker you want to delete, click and hold the left mouse button. While holding, drag the marker down, onto your document page, then let go of the mouse button. The tab will be gone. 

What if you want to have a whole paragraph line up at a certain point?

ALIGNING BLOCKS OF TEXT - PARAGRAPH FORMATTING TC "ALIGNING BLOCKS OF TEXT - PARAGRAPH FORMATTING" \f C \l "1" 
We can achieve this effect 2 ways. I’ll show you the Paragraph method first.

A typical resume might have several lines of text you want to line up under each other, such as a job description. You could of course set up a tab stop at the position you want the text to line up on, but that means you would have to press ‘Enter’ at the end of each line, then press ‘Tab’ to start the next line. This will result in too much space between each line. 

Let’s say we want our blocks of text to align themselves at the 1 ¼” mark.

With the cursor at the left margin, click the ‘Format’ tab on the menu, and click on ‘Paragraph’. You should see something like this:

[image: image5.png]e ]

e

Mgmert:  [BRCIs]  Owneleve:  [sodvese 7]
s

Left: 0" = Special By
Right: = frone) =)

s

Before: |Auto EI: Line spacing: At

e E= A

o

s

= o ==





In the section labeled ‘Indentation” find the box labeled ‘Left’. Either enter “1.25” or click the up arrow button until the value reads ‘1.3”’. Click the ‘OK’ button when done.

Now, we have a left indent set at the 1 ¼” mark. (Don’t forget it will actually be 2 ¼” from the left edge of the paper since we already have a 1” margin.) Let’s see what that does. I’m just going to keep on typing, regardless how long the line is. Hey, cool! The text wraps around to the next line but see how it always lines up with the line above? This will keep happening even if I hit the ‘Enter’ key to start a new paragraph.

See what I mean? We are still lining up at the left indent. How do we get rid of it?

Well, that was easy! After starting a new paragraph, hit the ‘Backspace’ key, and you will automagically delete the indent we inserted, and place the cursor back at the original left margin.

OK, we’ve learned 2 things: how to set a tab, and how to set a left indent.

Let’s put them both together on the SAME line! Whooeee! 

I’ve set an indent at 3/8”. Now I will set a left-aligned tab at the 5/8” mark.
ABC
This text starts at the tab.

DEF
The line starts at the indent set at 3/8”. After tabbing in to the tab stop, if we add more text to this line it will wrap around and start at the indent mark. This is not quite what we want for a resume.

What we really want is for any multi-line text to line up under the previous lines. Let’s try putting the tab ahead of the indent on the ruler line.
That didn’t work. With the indent coming after the tab, it acts as a new margin, and we can’t even get to the tab. But notice that our text lines up the way we want. Hmmm. What we want is called a ‘hanging indent’. Here’s how to set one up.

ALIGNING BLOCKS OF TEXT - the Hanging Indent TC "ALIGNING BLOCKS OF TEXT - the Hanging Indent" \f C \l "1" 
This is the first time I’ve mentioned this, so I’ll have to point out the marker, or button to you. At the left edge of the ruler at the top of your document, you will see 3 small buttons, stacked on top of each other. The bottom one is square, and the 2 above it look like up and down-pointing triangles. They look like this:
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and are just to the right of the tab marker button on the ruler.

The marker we want is the up-pointing triangle. Click and hold the mouse cursor on it, and while holding, drag it over to the 1 ¼”  mark on the ruler, then let go of the mouse button.


OK, now tab in to get to the indent, and let’s see what happens. As we enter text, it wraps around, but lines up at the indent position.

Hitting ‘Enter’ puts us back at the left margin. Hmmm.

1990
In 1990 I was employed by IBM at their Aruba branch office. While there I developed a serious sun-burn and was forced to return to North Bay.

1995
After intense skin therapy and healing medication, I was able to secure employment with Microsoft in their North Bay branch. My role there was to keep our presence a complete secret, which I believe I achieved successfully. To date no one knows Microsoft is here.

2005
Tired of always looking over my shoulder, I resigned from Microsoft without prejudice, and have since been spending my days writing help manuals for various government agencies.
Well, that looks like something we can use in a resume. I guess it’s a keeper.

But wait, here’s another way you can get columns to line up.
ALIGNING BLOCKS OF TEXT – TABLES TC "ALIGNING BLOCKS OF TEXT – TABLES" \f C \l "1" 
Tables are something you might be familiar with if you’ve ever used a spreadsheet, such as Excel. Because you are working with columns and rows already, it may be a little easier to visualize and use this method.

From the row of icons below the menu at the top of page, click the ‘Table’ icon. If you hold your mouse cursor over an icon, an information box will appear. The one for ‘Tables’ says ‘Insert Table’. When you click that icon, you will see what looks like a grid of squares. Hold down the left mouse button, and drag it across 2 squares in the top row, and drag down 3 rows. It will tell you the size of the table as you highlight cells. You want to see ‘3 x 2 Table’, then let go of the mouse button. You should see something like this where you had your cursor located.

	
	

	
	

	
	


Click in the top-left cell to place the cursor there.

Now enter in each cell the same data as we used in the example above, with years in the left most cells, and the text in the right-most cells. You can use the Copy-Paste technique (advised) or re-type everything. When you are finished you should have something like the following diagram.
	1990
	In 1990 I was employed by IBM at their Aruba branch office. While there I developed a serious sun-burn and was forced to return to North Bay.

	1995
	After intense skin therapy and healing medication, I was able to secure employment with Microsoft in their North Bay branch. My role there was to keep our presence a complete secret, which I believe I achieved successfully. To date no one knows Microsoft is here.

	2005
	Tired of always looking over my shoulder, I resigned from Microsoft without prejudice, and have since been spending my days writing help manuals for various government agencies.


Now, I know you’re saying, ‘Ewww, that looks too weird, with boxes around everything, and there’s too much space after the years.” Well smarty-pants, watch this.
Tables give you a lot of control because each cell is independent of the others. You can have each cell a different colour if you want. And anything in a cell can be formatted simply without affecting other cells.

You can also control each side of each cell (the border). 

But first we want to resize those column widths.

Place the mouse cursor over the middle vertical line of the table. It will change into a different shape, like 2 short vertical lines in between 2 arrows. When you have the cursor positioned correctly, hold down the left mouse button, and drag the line to the left. When it lines up with the 1” mark on the ruler, let go of the mouse button. You should see something like this:

	1990
	In 1990 I was employed by IBM at their Aruba branch office. While there I developed a serious sun-burn and was forced to return to North Bay.

	1995
	After intense skin therapy and healing medication, I was able to secure employment with Microsoft in their North Bay branch. My role there was to keep our presence a complete secret, which I believe I achieved successfully. To date no one knows Microsoft is here.

	2005
	Tired of always looking over my shoulder, I resigned from Microsoft without prejudice, and have since been spending my days writing help manuals for various government agencies.


OK, that’s not bad, but what about those lines? Let’s lose them. 

First, click in any cell in the table to place the cursor in the table. From the top menu bar, choose ‘Table’. Scroll down and then follow the ‘Select’ choice and pick ‘Table’. This selects the whole table. 

	1990
	In 1990 I was employed by IBM at their Aruba branch office. While there I developed a serious sun-burn and was forced to return to North Bay.

	1995
	After intense skin therapy and healing medication, I was able to secure employment with Microsoft in their North Bay branch. My role there was to keep our presence a complete secret, which I believe I achieved successfully. To date no one knows Microsoft is here.

	2005
	Tired of always looking over my shoulder, I resigned from Microsoft without prejudice, and have since been spending my days writing help manuals for various government agencies.


Under the same ‘Table’ tab, scroll down to the bottom and click on ‘Table Properties’. You will see the following box open up.
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With the ‘Table’ tab selected as above, click ‘Borders and Shading’ to get the following box: 
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Notice in the right panel labeled ‘Preview’, there are several buttons, each with a small square on it. Each button controls a particular side or border of a cell. The buttons are toggles, which means if that feature is on, clicking the button turns it off. If it is off, clicking turns it on.
The preview image in the middle will help you see what effect clicking each button has. Play with them until you are comfortable with how they work, keeping an eye on the preview image. Don’t worry; nothing in your document will be affected until you click ‘OK” at the bottom.

Since we don’t want any lines around our text, we have to click the 3 buttons controlling horizontal borders, and the 3 buttons controlling vertical borders. Guess which ones they are?

Don’t click the boxes with diagonal lines through them. Well, OK, go ahead and click them to see what happens. Cool eh?

OK, now quit playing around and get back to the other boxes. Check the preview image and make sure there are no horizontal or vertical borders appearing. Click ‘OK’ when you’re done.

You should now have something like the following. How is it any different from what we did using tabs and indents?

	1990
	In 1990 I was employed by IBM at their Aruba branch office. While there I developed a serious sun-burn and was forced to return to North Bay.

	1995
	After intense skin therapy and healing medication, I was able to secure employment with Microsoft in their North Bay branch. My role there was to keep our presence a complete secret, which I believe I achieved successfully. To date no one knows Microsoft is here.

	2005
	Tired of always looking over my shoulder, I resigned from Microsoft with extreme prejudice, and have since been spending my days writing help manuals for various government agencies.


JUSTIFY A LINE – TABLE METHOD TC "JUSTIFY A LINE – TABLE METHOD" \f C \l "1" 
Sometimes we have a line of text which we want to align part of with the left margin, and the rest with the right margin. A typical scenario where you might find this is in your address block at the top of your resume or cover letter. Here is an example of what I mean:

	Amer Neely
	w: www.softouch.on.ca


How did I do that? You can’t use the ‘Align Right’ button, as that will line up whatever you type with the right margin. You can try setting up tabs, but if you have more than one line to format the same way it gets a little clumsy.

The secret is to set up a 1 x 2 table. Then in each cell, enter the text you want to align separately. By default, all text is left-aligned, so you don’t have to worry about the name text. When you have entered your text in the next cell (by clicking in it, or using the ‘Tab’ key), highlight it, and click the icon for ‘Align Right’ at the top of your page. 
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Finally hide all the borders in the table like we did above.

By using a table, you have complete control over every part of your text. Using the above example, you can keep entering text in each cell, even hitting ‘Enter’ to start new lines. 
	Left-aligned

Centered

Back to left-aligned
	Right-aligned

Centered

Back to right-aligned


JUSTIFY TEXT BLOCKS TC "JUSTIFY TEXT BLOCKS" \f C \l "1" 
Using the same icons displayed above we can format blocks of selected text easily. Once you have the text selected, click the appropriate formatting icon. By default, text is left-justified, meaning the left margin lines up nicely while the right margin is ‘ragged’.

However, 

Using the same icons displayed above we can format blocks of selected text easily. Once you have the text selected, click the appropriate formatting icon. By default, text is left-justified.

we can also have it right-justified, as above. Now the right margin is aligned and the left margin is ragged.

Or …. 

Using the same icons displayed above we can format blocks of selected text easily. Once you have the text selected, click the appropriate formatting icon. By default, text is left-justified.

centered.

Finally we can have it fully justified:

Using the same icons displayed above we can format blocks of selected text easily. Once you have the text selected, click the appropriate formatting icon. By default, text is left-justified.

This makes both margins align by spreading out the words and letters. This formatting method only works well in specific situations.
ADJUSTING LINE SPACING – PARAGRAPH FORMAT TC "ADJUSTING LINE SPACING – PARAGRAPH FORMAT" \f C \l "1" 
As you may notice in the above example, pressing ‘Enter’ to start a new line adds some extra space between lines. This is a default action, since most times you hit the ‘Enter’ key you want to start a new paragraph, so the word processor adds an extra blank line for you.

But in some cases, such as in our letterhead example above, we don’t want a blank line, just a new line. Here’s how to adjust how the line spacing works.

Open the ‘Format’ option of the menu bar, and click ‘Paragraph’. In the section labeled ‘Spacing’ you will see 2 text boxes labeled ‘Before’ and ‘After’. They are probably set at ‘Auto’. You want to set them both to ‘0 pt’. 
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Click ‘OK’ when done. Now, when you hit ‘Enter’ on a line, it will start a new line, but there will not be an extra blank line added above it. If you do want a blank line, just hit ‘Enter’ again. This is more typical of how a typewriter works.

Let’s see how this changes our letterhead example above.

	Left-aligned

Centered

Right-aligned

Back to left-aligned
	Right-aligned

Centered

Left-aligned

Back to right-aligned


Ah, that looks a little better.

BULLETS TC "BULLETS" \f C \l "1" 
No need to run and hide from these bullets. We use bullets to focus attention on specific points in our document. Good candidates for bullets are lists of things, or a short set of instructions. For our purposes a resume might use bullets to present certificates or degrees we have acquired.

Get out of bed
Get dressed

Eat

Work

Eat

Home

Eat

Get undressed

Go to bed

If the text we want bulleted is already entered as above, just select the whole block, then click the ‘Bullets’ icon in the toolbar above the ruler.
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· Get out of bed

· Get dressed

· Eat

· Work

· Eat

· Home

· Eat

· Get undressed

· Go to bed

You can choose different types of bullets if you select the text, then click the right mouse button. Click the ‘Bullets and Numbering’ link to see some different choices.
WRAP IT UP TC "WRAP IT UP" \f C \l "1" 
OK, that about does it! Of course there are lots of things you can still go on to learn about word processing. I hope this guide has piqued your interest but even more I hope it is useful to you. Go on now, be free!
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